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1 INTRODUCTION 

 
This document is the functional specification for the AxiSoft Process Control 
part of AxiBatch Concrete Batching System. 
 

1.1 License Agreement 

 
The AxiSoft software is licensed to the end user to be installed on one 
computer per individual license.  This software requires registration whereby 
the installed computer ID is required. 
 

1.2 Publishing Rights 

 
Axion Control Systems Pty Ltd reserves the right to make periodic changes, 
revisions, specification enhancements and alterations of any kind to the 
product and this manual without obligation to notify any person(s), institution 
or organisation of such changes, revisions, enhancements and alterations. 
 

1.3 Publishing Details 

 
Axion Control Systems authors have taken due care in the preparation of this 
document and every attempt has been made to ensure its accuracy and 
completeness. In no event will Axion Control Systems be liable for damages 
of any kind, incidental or consequential, in regards to or arising out of the 
performance or form of the material presented in this document. 
 
Axion Control Systems encourages feedback about this document. Please 
send any written comments to the Technical Support Department. 
 
 
 

 
Trademarks 
 
Windows 10, 8, 7, 2000, NT, XP and Vista are trademarks or registered trademarks of 
Microsoft Corporation. Microsoft ® are trademarks or registered trademarks of Microsoft Corp. 
Axion are trademarks or registered trademarks of Axion Control Systems, all other 
trademarks or registered trademarks are the property of their respective owners. 
 
© 2018 Axion Control Systems Pty Ltd.  All rights reserved 
 
No part of this publication may be reproduced, copied, transmitted, transcribed, plagiarised, or 
translated into any language in any form by any means without the written permission of 
Axion Control Systems Pty. Ltd. 
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1.4 Definitions 

 
FULL RUNNING When a Hopper is first to start and will be 

discharged. 
 
PART RUNNING When the 2nd Hopper has started, it is Part 

Running. Cement will not be batched until the 
Cement hopper is empty in the Full Running batch. 
2nd Hopper will not discharge until the 1st Hopper 
has completed it's discharge which is when the 
2nd Hopper will become Full Running. 

 
MOXA DEVICE SERVER A Serial Device Server connecting to AxiSoft via 

an Ethernet port. Can usually have 1 to 16 serial 
ports being serviced. 

 
MOXA ioLogik industrial Ethernet remote I/O configured using 

ioSearch software. AxiSoft uses these modules to 
control solenoids and motors and to read status of 
devices. 

 
 

1.5 Features 

 
AxiSoft is designed to run on a Microsoft Windows operating system. The 
AxiSoft software package was written using Microsoft C# and requires Net 
Framework 4 to run. This software should run on most Microsoft operating 
systems that use NetFramework 4, which includes XP Service Pack3 and 
Windows 7, 8 and 10. 
 

1.6 Drivers Available 

 
Remote Scale Displays 
LED100 
EZMargqee LED Displays 
Ranger D640 
Ranger D840 
AxiTrek In-Cab Display 
 
Scales 
Ranger 5000 and 400 Series 
Ranger 5100 Batch Series 
 



AXISOFT MANUAL                  22/06/2018 

 

Page - 6 

I/O 
Moxa ioLogik E2210 - 12x 24VDC Inputs / 8x Transistor Outputs (0.5A) 
Moxa ioLogik E1214 - 6x 24VDC Inputs / 6x Isolated Relay Outputs (2A) 
Moxa ioLogik E1210 - 16 x 24VDC Inputs 
 
Note:  Any inputs can be configured as a Counter (i.e. Water & Additive pulses) 

 

1.7 Recommended Computer Requirements 

1.7.1 Minimum Hardware Requirements (in addition to standard PC 
specs) 

 

 Intel Core i7-4790 Processor (Quad Core) – eg 
http://www.dell.com/au/business/p/optiplex-9020-desktop/fs  

 16GB Memory 

 256GB Solid State Drive (SSD) – boot up drive 

 1TB Hard Disk 

 Wireless Card 

 2x Ethernet Ports (for 2 LAN networks) 

 CD/DVD Drive 

 USB Keyboard / mouse 

 Hi-Res 1GB Graphics Card with capacity for 2 monitors 

 2x Hi-Res 24” Colour Monitors 

 1400VA UPS with under 5ms transfer time – eg 
http://www.anyware.com.au/categories/power/uninterruptable-power-
supplies/ups-domestic-office/ds1400.html 

1.7.2 Software Requirements 

 

 Windows 7 or 10 Professional (do not use Windows 8) 

 Microsoft Office (with Excel, Word and Outlook) 

 Avast Antivirus 

 

One Ethernet connection is for connecting all the IO Modules, scales and 
remote displays.  The other connection is for connection to the office network.  
This will alleviate unnecessary traffic on the office network. 
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2 AXISOFT SOFTWARE 

 

2.1 Launching AxiSoft 

 
Double Clicking the AxiSoft Server icon on the desktop will launch the AxiSoft 
Server software.  The screen below will be displayed. 
 

 
 

2.2 Logging In 

 
AxiBatch software identifies three user levels and their passwords for 
authentication and protection. 
 

Level 1 Operator user name only gains access to viewing 
Reports. 

 
 
 
Level 2  Administrator user name has access to the same 

functions as the operator plus access to most of the 
settings. 

 
 
 
Level 3  Technician user name gains full access..  

 
 
 

 
 
 
 
 

Level 1 - Operator 

Level 2 - Administrator 

Level 3 - Technician 

Password Required 
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The Server software will automatically come with 3 user names. They are 
Operator, Administrator and Technician. 
 
You will need the Administration / Technician level to be able to configure 
most functions. 
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3 AXISOFT SETUP 

 
To setup the AxiSoft settings it is necessary to login with an appropriate level 
in order to gain access to the "Settings" page. 
 
To gain access to the settings screen click on Tools => Settings. 
 

3.1 Hoppers 

 
This applies for setting up Aggregate Hopper 1 / 2, Cement and Water 
Hoppers. 
 
Indicator - Check this to enable the Indicator to work. 

 
Model 

 Select "Rinstrum 5000" for continuous weights for R5000/R5100 & 
R5200 units 

 Select "Rinstrum 5100 Command" for command control only for R5100 
& R5200 units when in command mode 

 Select "Rinstrum 5100 Weights" for continuous weights for R5100 & 
R5200 units only when in command mode (this is slower than 
'Rinstrum 5000' mode. 

 
IP Address - the IP address of the MOXA Serial Device Server. 
 
Port - The port number assigned in the MOXA device for that indicator. 
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3.2 Remote IO Modules 

 
This section describes the setup of the IO Modules. 
 

3.2.1 IOModules General Settings 

 

 
 

3.2.1.1 Response Time Factor for alarm Message 

No longer used 
 

3.2.1.2 Response Time Factor for Handle Reset 

No longer used 
 

3.2.1.3 Disable Watchdog Read 

If running IO modules in ASYNCH mode will stop the program from checking 
for the Watchdog bit. Typically should not be checked, and checked if you are 
testing or wanting more speed and have a very reliable network. 
 

3.2.1.4 Run IO Logic in Block Mode 

If this is checked will run IO modules in blocking mode, not it Asynch Mode.  
Use this for modules that have a minimum Firmware of V2.3 Build 15031013. 
These modules have an automatic watchdog reset and blocking mode does 
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not monitor the watchdog bit and does not reset. This is the preferred mode to 
use. 
 

3.2.1.5 Thread Sleep Time Between Output and Input Read 

This time in milliseconds between when a Read Block is finished and before a 
Write Block is executed and is only used If Blocking Mode is checked. 
 
 

3.2.2 IO Modules Settings 

 

 

3.2.2.1 E1210 

 
This module consists of 16 Digital Inputs. 
 

3.2.2.1.1 Input Modes 

All Digital Inputs - 1 Read  
 
Counter Values - 2 Reads (2nd Read reads the Status of the Counters - 
Stopped/Running). 
 

3.2.2.1.2 Output Modes  

Should be set up for Change Of State - Only used if Controlling Counters. 
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3.2.2.2 E2210 

 
This module consists of 12 Digital Inputs and 8 Transistor Outputs. 
This module has high speeds of communication transactions. 
Input Read Transactions are about 4ms. 
Output Write Transactions are about 5ms. 
 

3.2.2.2.1 Input Modes 

1st Read - Takes Output Status and Counter Status if required. 
2nd Read - Takes Counter Values otherwise will read Digital Input Status. 
3rd Read - Takes Digital Input Status if Reading Counters as well. 
 

3.2.2.2.2 Output Modes 

Should be set up for Change Of State for efficiency. 
 

3.2.2.2.3 Module Configuration 

This module requires no modification of the Modbus Registers. 
 
Only the configure inputs for Counters if required. 
 

3.2.2.3 E1214 

 
This module consists of 6 Digital Inputs and 6 Relay Contact Free Outputs 
This must be used to interface to Additive Meters ME2008 using Outputs 
 
Input Read Transaction Time - 18ms 
Output Write Transaction Time - 15ms 
 

3.2.2.3.1 Input Modes 

1st Read - Takes Output Status / Input Status and Counter Values 
2nd Read - Takes Counter Status 
 
Counter Status will only be read before an Additive/Water is batched to 
ensure the Counter is in the START state. It is also read whilst monitoring the 
IO with IO Viewer. 
 

3.2.2.3.2 Output Modes 

Should be set up for Change Of State for efficiency. 
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3.2.2.3.3 Module Configuration 

This module requires the following Modbus Register modifications using the 
Moxa 'ioSearch' software (see ioSearch section below). 
 

DO (Relay) (Ch0-5) 0032 03:HOLDING REGISTER 40033 

DI Value 0033 03:HOLDING REGISTER 40034 

DI COUNTER 0039 03:HOLDING REGISTER 40040 

 
Only configure inputs for Counters if required. 
 
All Outputs should be configured as follows: 

- Power On Setting should be set to "OFF" 
- Safe Status Setting should be set to "OFF" 
- In General Settings the Watchdog needs to be enabled & set to 3sec. 

 
 

3.3 Control Settings 

 
 

 
 

3.3.1 Engine Cycle Time 

Sets the Engine Cycle Time. Leaving it a zero the engine will cycle as fast as 
it can. 
 
If you set it 100ms, it will cycle and wait until 100ms has timed before cycling 
again. 
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3.3.2 Communication Retry Time 

Is the retry time before communications to the device's indicator is re-tried 
after a fault. Do not set lower than 30 seconds. 
 

3.3.3 TCP Server Delay After Read 

Time in milliseconds after a TCP Server has read a weight reading that the 
driver will be blocked before another attempted read.  The more time you 
have the more time that is allocated for other drivers.  
 

3.3.4 TCP Server Delay in Main Thread 

Time in milliseconds that a TCP Server will be blocked for at each cycle. Use 
in combination with “TCP Server Delay after Read” to achieve the best 
performance. 
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3.4 Aggregate Bin Storage or Holding Bin 

 
The following shows options for Storage or Holding Bin 
 

Destination – Select #Bin1 if going from a Holding Hopper to a Bin Weigh Hopper, 

select “Agg Weigh Hopper #1” is going from a Holding Hopper to an Aggregate 

Hopper 1, select “Agg Weigh Hopper #2” is going from a Holding Hopper to an 

Aggregate Hopper 2 

 

Note that a Holding Hopper can have a Course Valve and a Trim Valve and has no 

Load Cells, so its destination must be a hopper with load cells. 
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3.5 Control Aggregates Settings 

 

3.5.1 Main Conveyor Delay On Time (Warning Bell Time) 

If this time is set to 0 the main conveyor will start straight away. If a time is set 
then the Main Conveyor will be delayed by this time, however during this time 
is when the Warning Bell is sounded. 
 

3.5.2 Main Conveyor to Piggy Conveyor Delay 

This is delay on time for the secondary conveyor to start after the Main 
Conveyor. The main conveyor feedback must be on if it is configured for the 
piggy back conveyor to run. 
 
 

3.5.3 Agg1 or 2 Gates Delay OFF when Weight is below Empty Band 

When the weight falls below the Empty Band weight, they must stay on for this 
minimum time before they close. 
 

3.5.4 Enable Gate Inching Initial Solenoid Time Algorithm 

This will enable the initial inching algorithm. Usually there is a set initial time 
that is sent by AxiBatch in milliseconds. The algorithm will provide a linear 
equation to calculate the initial solenoid opening time based on the weight in 
the hopper before opening the solenoid. Typically the more weight in the 
hopper the longer the initial time you want to use as it will harder to open. The 
values will be experimental and will vary from site to site. You may want to 
start with a Max Weight of around 10000kg and a min weight of 1000kg, with 
solenoid times of 500ms to 1000ms.  
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3.6 Control Cement Discharge Settings 

 

 
 

3.6.1 Completely Empty Cement Hopper when Discharging 

When checked this will make sure all the Contents of the Cement Hopper is 
emptied during discharge. 
 

3.6.2 Cycle Cement Hopper Discharge Valve 

When checked will open the discharge valve for the Open Time and closed 
for the Close Time. But will keep open when below a certain weight. This 
applies only to the CemHopper1Gate output (I.e. Non Inching Valve) 
 

3.6.3 Start Discharging Cement when the Aggregate Hopper has less 
than X % remaining 

When enabled Cement will not discharge unless less than X% of Aggregate 
is remaining. I.e. if set to 90% , then Cement will be enabled to discharge 
when there is 89% or less of Aggregate in the Hopper remaining. 
 

3.6.4 Cement Hopper X Dump Delay Time 

When Cement Discharge is enabled this is the Delay time before the Cement 

Discharge gates will open. 
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3.6.5 Cement Hopper X Top Up Start & Stop Weights 

This is the start up weight when a Silo will start to transfer it's cement to this 
Hopper. The Silo must have its mode set to "Auto Top Up" and it's 
destination must be this Hopper. The transfer will stop once the hopper 
weight is above the "Top Up Stop Weight". When discharging to Truck from 
the hopper AxiSoft will unload only the Recipe weight. Make sure the 
"Completely empty Cement Hopper Weight" is set to OFF. 

 

3.6.6 Dust Collector Delay Off 

Dust Collector delay Off time. When discharging has finished for longer than 
this time this is the time the Dust Collector will turn off. 
 
 

3.7 Cement Batch General Settings 

 
Cement Batching general Settings. 
 
Possible configurations 
 

 Cement Hopper 1 is Batching (Silo’s 1, 3 & 4) can be batched to 
Cement Hopper 1 and Cement Hopper 2 is a Silo (Silo 2).  

 Cement Hopper 1 is Batching and Cement Hopper 2 is Batching 
 Cement Hopper 1 is a Silo, and Cement Hopper 2 is a Silo 

 

3.7.1 Common Silo Filter Delay Off  

Delay Off time to turn off the common Silo Filter when Silo is not running out 
Cement. Output it controls is 'SiloFilter' 
 
 
  



AXISOFT MANUAL                  22/06/2018 

 

Page - 19 

 

3.8 Cement Silo’s 1 to 4 Settings 

 
Silo Settings. 

 

3.8.1 Outlet Valve On Delay 

Delay On Time for Silo Outlet Valve to open. 
 

3.8.2 Auger On Delay 

Delay On Time for Silo Auger to start and is usually after the Outlet valve is 
open if configured. (Currently Not Used or programmed in) 
 

3.8.3 Mode 

Silo Mode can be Normal or Auto Top Up. 
In Normal Mode cement is Batched to it's destination Hopper. 
 
In Auto Top Up mode the Destination Cement Hopper is topped up from this 
Silo. See Cement Hopper settings for the Start and Stop Top Up weights. 
 
 

3.8.4 Destination 

Destination Hopper this Silo will send it's Cement to. 
"Truck" does not do anything but just a reminder that this Silo is not used as 
AxiBatch has it settings that the Silo is a Cement Hopper. 
 
 

3.8.5 Slide Valve Mode 

Silo Slide Valve Mode, Default is Normal  
 
Normal - Slide valve is always on when discharging into Hopper 
Pulsed - Slide Valve is Pulsed when discharging into the Hopper using the 
Pulse On and Pulse Off Times 
 
The Slide Valve Delay on is the delay on time before it will open the Slide 
Valve. 
 

3.8.6 Silo Filter Delay Off Time 

Not currently used or programmed in. Future for controlling the Silo Filter. 
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3.9 Water Settings 

 
TBF 
 
 
 

3.10 Truck Bay Settings 

 
Check 
'Run Display in AUTO mode' to send aggregate data to the Remote Display 
when system is in AUTO mode 
 
'Run Display in Off mode' to send aggregate data to the Remote Display when 
system is in not in AUTO or MANUAL mode. Leave off if you need the display 
to re-power. 
 
'Run Display in MANUAL mode' to send aggregate data to the Remote 
Display when system is in MANUAL mode 
 
Set the Green Lamp Delay off time to save power! 
 
 
 

3.11 Backup Settings 

 
To backup settings use File => Save Settings. 
Then use the file dialog box to save Settings file to a desired location. 

 
 
 

3.12 Restoring Settings 

 
To restore settings use Tools => Restore => Settings. 
Then use the file dialog box to locate and restore from the previously saved 
Settings file. 
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4 AXISOFT ALARMS 

 
The following sections describe alarming and fault finding. 
 

4.1 Main Display 

 

 
 
Emergency Stop Status, will show OK if not configured as an input. If 
configured could show that the Emergency Stop circuit has activated. 
 
Mode Status. Will show Auto Mode, Manual Mode, Off Mode or Software 
Manual Mode. 
 
The main grid shows the status of the PLC Engine, and connection status to 
AxiBatch software. 
 

4.2 Alarm Summary 

 

 
 
Alarm Summary displays all active alarms.  Right click on the Alarm to either 
view more details or to acknowledge it. 
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5 DEVICES 

 

5.1 RANGER 5000 or 5100 

 

Activity R5000 R5100 Comment 

Discharge Table 

Control 

Yes No However can use 

R5100 as R5000 

Pause Cement Yes Yes  

Abort Cement Yes Yes  

Direct Auger 

Control 

From AxiSoft From R5100 Additional costs if 

R5100 

Inflight Control Yes Yes  

Possible 

Overweight 

Yes Unlikely Possible 

Overweight 

 
MOXA Serial Device Servers (aka Serial-Ethernet converters) must be used 
to connect AxiSoft to these indicators – see Moxa setup section below. 
 

5.1.1 Indicator Setup 

 
Use the first serial port on the indicator for communications. 
 
In summary, set to Protocol A and to AUTO HI. The BAUD Rate, Data Bits, 
Stop Bits, Parity must match the MOXA and the Terminator used must be '03' 
which is the ETX character. 
 
Note:  Full Setup ZERO and SET key for 2 seconds 
 
If using drop in weight make sure that the Direction for the Material is set to 
"Under" otherwise set to "Over". 
 

Item Display Set To 

Serial Output 1 (Ser1) Auto.Hi 

Auto Output Format 
 (Auto Transmit Options 
- Aut.OPt) 

(TYPE) Auto.A (default) 

Auto output Source (Src) rdg / DISP (Display) 

Start Character (St.Chr) 02    (STX) or 00 (NULL) 

End Character 1 (End.ch1) 03    (ETX) or 13 (CR) 

End Character 2 (End.ch2) 00    (NULL) or 10 (LF) 

Baud Rate (bAUd) 9600 (default) 

Bitmap Pattern (bitS) N81-2- (default) 
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No Parity, 8 data Bits, 1 
Stop Bit, no terminator 
resistor, RS232, no 
handshake 

   

For R5100 Command 
or Weights Only mode 

  

Serial Output 1 (Ser1) NET 

NET.OPT (ADDRES) 01 for Cement Hopper 1 
02 for Cement Hopper 2 

 (TYPE) NEt.A 

 
 

  

 
Quick Setup (Safe Setup for a R5000) 
 

 Press Gross/Net for more than 2 seconds to enter Safe Setup mode 

 Press the ZERO button to scroll thru the groups, until you get to “Serial: 

 Press the TARE button to step through the items in that group 

 Most items will be default but Serial 1 needs to be set up to Auto.hi and Serial 

2 needs to be set up to auto.lo 

 Use GROSS button to display item or digit and use PRINT button to change 

entry 

 To exit press ZERO key until END appears and then press ITEM to exit and 

save 

 

5.1.2 Moxa Device Server Setup 

 
In Network settings, set the IP Address and set IP Configuration to "Static". 
 
In serial Settings, set Interface to RS232 only and the Baud Rate and Data 
parameters must match the Indicator.  Also set Flow Control to "None". 
 
In Operation Settings, set: 

- Operation Mode to 'TCP Server Mode' 
- Local TCP Port to same Port as in AxiSoft (must not be used anywhere 

else!) 
- TCP Alive Time to "1" minute 
- Max Connections to "1" 
- 'Delimiter 1' to "03" and Enable it (ETX Character). 

 
When using Command Mode set: 

- 'Delimiter 1' to "d" and Enable it (CR Character) 
- 'Delimiter 2' to "a" and Enable it (CR Character). 
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5.1.3 Serial Cables 

 
This applies to Aggregate Hopper 1 / 2, Cement and Water Hoppers. 
 

Indicator Pin 
(Indicator) 

5 Pin 
Adapter 

Moxa Pin (Moxa) 5 Pin 
Adapter 

TxD 3 3 RxD 2 1 

RxD 2 1 TxD 3 3 

G 5 5 G 5 5 

 
Note:  5-pin adapter can be purchased from Axion, and is cabled up using 
screw terminals. 
 

5.2 RINSTRUM D840 

 
This device is a Remote Display Indicator for displaying Aggregate information 
to the Front End Loader driver. It will only display the first 6 letters of the 
material code alternating between weight and code. 
 

 
 

5.2.1 D840 AxiSoft Setup 

 
Select "Rinstrum D840" for the Model 
Always select Port 10001 
Enter correct IP Address 
Node Number is irrelevant for the D840 
Display Name is also irrelevant 
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Under the Control->Ranger Display section you have additional options. 

 
Weight On Time - the time period the Weight is displayed when alternating 
between weight and material 
 
Material On Time - the time period the Material Code is displayed when 
alternating between weight and material 
 
Will Alternate between Weight and Material Code when weight is below a 
certain amount (80 kg)or when no weight has been added for (5000 ms). 
 
Flash Green light when on Part Running load with duty cycle of 600ms. 
If set to zero will not flash on a part running load. (It will not come on at all) 
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5.2.2 Setting up the D840 IP Address 

 
Use the Lantronix Device Installer software to do this. (Min V4.4) 
You can download this from 
 
http://ltxfaq.custhelp.com/app/answers/detail/a_id/644 
 
Connect the D840 to your router. The router should automatically assign an IP 
address to it using DCHP. 
 
Run the Lantronix Device Installer software to locate the unit. 
(Lantronix folder -> DeviceInstaller) 
 
If the Multiple network adapters prompt comes up you need to select yes, and 
then choose the network adapter your D840 is connected to. 
 
Use the Assign IP button to change the IP address for the Customer. 
 
 
 

5.2.3 Wiring the D840 

 
Power Connector (240VAC) 
L Terminal - Active Red 240VAC 
N Terminal - Neutral 240VAC 
E - Earth (may show earth symbol) 
 

 
 
 
Ethernet Connection 
D840 Pin 1 - Ethernet Tx+ White/Orange (Pin 1) 
D840 Pin 2 - Ethernet Tx- Orange (Pin 2) 
D840 Pin 3 - Ethernet RX+ White/Green (Pin 3) 
D840 Pin 4 - Ethernet RX- Green (Pin 6) 
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Note – Do not worry about using Pins 5 and 6 for traffic lights as these lights 
can be controlled via the AxiSoft program. 
 
 
 

5.3 EzMarquee 

 
This device is a Remote Display Indicator for displaying Aggregate information 
to the Front End Loader driver. It can display the first 10 letters of the material 
code at the same time as displaying weight. 
 

5.3.1 EzMarquee AxiSoft Setup 

 
Select "EZMarquee" for the Model 
Always select Port 49999 
Enter correct IP Address 
Node Number is irrelevant for the EZMarquee 
Display Name is displayed with weight in non batching conditions (10Char) 
 

5.3.2 Setting up the IP Address 

 
Use the EZMarquee software Min V1.2.27  
(Contact http://www.balmoral.net.au/ for this) 
You need to connect via a serial able first. 
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Go to the "Marquee Communication Setup" 
 
 

 
Select the correct COM Port 
The serial port default baud rate is 9600 baud, 8 Data Bits, No Parity and 1 
Stop Bit 
(Select the correct parameters if necessary, in the PC Communication Setup) 
 
On the "Marquee Communication Setup" 
select "Ethernet" for Network Type 
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Click on set to default valves button and OK. 
 
Enter the Desired IP Address, Subnet mask and Gateway address. 
 
Set Group to 1 and Unit to 1. 
 
Press the "Program Marquee" button this should program the Marquee. 
 
Reboot the Marquee, the correct IP address will show on startup. 
 
 

5.3.3 Wiring the EZMarquee 

 
This is straight forward and uses a standard Ethernet connection. 
A housing would be required if you don't have the IP67 version. 
 
 

5.4 Moxa ioLogik IO Server Setup 

 

5.4.1 ioSearch Software 

 
Run the Moxa "ioSearch" software. 

 
 
Select the modules you want to read and press "Start Search". 
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5.4.1.1 Changing IP Address (with PC on same network as ioLogik) 

 
 
 
Select the module on the left pane and select "Ethernet Configuration" under 
Overview->Network Settings. 
 
Set 

- the IP Configuration to "Static" 
- the IP address to what you need etc... 

 
Press "Submit" 
 
Press "Save/Restart" 
 
Exit Software and Start again. 
 

OR if no page appears 
 
Select Module, then right click and select "Change IP address". 
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5.4.1.2 Changing IP Address (with PC on different network to 

ioLogik) 

 
Run ioSearch software.  Select the modules you want to read and press "Start 
Search". 
 
New modules will be detected as a 192.168.127.254 
 
Change your adapter IP to 192.168.127.150 (for example) 
 
Select the module Part Number (Eg. E1214) and right click on it. 
 
Select "Change IP Address" 
 
Click into the "IP Address" field 
 
Type in the new IP Address. 
Press the small button inside the field on the right. 
 
Press the "Submit" button and select "Yes" 
 
Wait for IO Server to Restart Message will appear, 
When finished press "OK" 
 
Press "Exit" button. 
 
It will ask you for a new search. Press "Yes". 
Press "Start Search" 
Module should now appear with new IP address. 
 
Repeat until all modules are done. 
 
Change your Ethernet adapter (PC) back to the original IP address. 
 

5.4.1.3 E1214 Setup 

 
The E1214 needs to be set to the following 
 

DO (Relay) (Ch0-5) 0032 03:HOLDING REGISTER 40033 

DI Value 0033 03:HOLDING REGISTER 40034 

DI COUNTER 0039 03:HOLDING REGISTER 40040 

 
1. Press on the Module IP Address (Left pane). On the right Pane the 

Main Screen will appear 



AXISOFT MANUAL                  22/06/2018 

 

Page - 32 

2. Select "Digital Inputs/Outputs" under Main Menu - E1214 => Overview 
=> User Defined Modbus Address 

3. Check "Enable User-defined Modbus Addressing" the user defined 
fields and function codes fields will be enabled 

4. Change DI Value from 0000 to 0033 and Input Status to Holding 
Register 

5. Change DI Counter from 0016 to 0039 and Input Register to Holding 
Register 

6. Press "Submit" 
7. Press "Save/Restart" 

 
Example  

 
Note 
Change 15 DO (Relay) Pulse Count from 0036 to 0074 
(for newer firmware versions) 
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5.4.1.4 E1214 Output Settings 

 
In Network Settings => General Settings: 

- Enable the "Enable Server Socket Idle Connection Time Interval" and 
set to 1 second 

- Enable the "Communication watchdog" and set to 1 second. 
- Enable the "Auto clear alarm for safe mode" 
- Press "Submit" when finished. 

 

 
 
 
 
In IO Settings => DO Channels, select each output channel (Eg. DO-00) 

 
 

 
 
For each Output set the "Safe Status Setting" to "OFF" for all Outputs. 
Submit for all outputs. 
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If the output is to CLOSE an Inching Valve, you can set this to "ON" to prevent 
spillage in case of a network issue.  
 
At the end: 
 
Select Save/Restart (Bottom left menu) 
 and then press Submit to save your changes. 
 

IMPORTANT 
Wait until it is back then Power Off and then On the unit. 
 

5.4.1.5 Setting an Input to be a Counter 

 
AxiSoft has several inputs that are Counter Type inputs.  These must be 
configured as Counters in the Input Module. 
 
E.g. E1214 Input 02 is an Additive Pulse 
 

1. Go to the DI Channels (Main Menu E1214 => Overview => I/O settings 
=> DI Channels) 

2. Click on DI-02 
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3. In item 1 change the current setting from DI to Counter 
4. For Filter set to 1ms 
5. Counter Trigger should be Lo to Hi 
6. Check on "Counter Start/Enable" on items 1,2 & 3 
7. Press "Submit" 
8. Press "Close". 

 
 

 
 
The input should have "counter" in the Mode column. 
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5.4.1.6 E1240 Analog Input Module Settings 

 
To set to current input set to Current mode as in the diagram below. 
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6 OUTPUTS 

 
This section describes all Outputs available to the system and how they 
function. 
 
Those highlighted in orange are for future and may not be functional. 
 
 

6.1 Control of Outputs 

 
The order of control priority for outputs is as follows: 
 

1. Forced On/Off (Highest Priority) (These are on individual basis) 
2. Manual Control (External Hardwired Switches - Must have a Manual 

Mode input) 
3. Software Manual Control (Software Manual Control Panel) 
4. Automation (from Sequences, Auto Input is not necessary and this will 

always be case when the 1st 3 options are not in effect). 
 

6.2 Storage / Holding Bin Outputs 

 

Name Operation Description 

StorageBin1Gate Valve(s) to transfer material from Storage Bin 1 to Weigh Bin 1, 

this valve can be pulsed based on load size 

StorageBin1GateTrim Trim Valve(s) to transfer material from Storage Bin 1 to Weigh 

Bin 1, this valve can be pulsed based on load size and can operate 

independent of the StorageBin1Gate 

StorageBin1Vibrator Storage Bin 1 Vibrator 

  

 
  



AXISOFT MANUAL                  22/06/2018 

 

Page - 38 

6.3 Aggregate Weigh Bin Outputs 

 

Name Operation Description 

Bin1Gate1 Normal Operating Gate from Bin 1 to Conveyor or Agg Hopper 

Bin1Gate2 Normal Operating Gate 2 from Bin 1 to Conveyor or Agg Hopper 

Bin1Gate1Open Gate 1 Inching Valve Open Signal to Conveyor or Agg Hopper 

Bin1Gate1Close Gate 1 Inching Valve Close Signal to Conveyor or Agg Hopper 

Bin1Gate2Open Gate 2 Inching Valve Open Signal to Conveyor or Agg Hopper 

Bin1Gate2Close Gate 2 Inching Valve Close Signal to Conveyor or Agg Hopper 

Bin1Vibrator Bin 1 Vibrator 

Bin1GateTrim Future 

  

 
 
 

6.4 Aggregate #1 Hopper Outputs 

 
This applies to Aggregate Hopper 1 / 2, Cement and Water Hoppers. 
 

Name Operation Description 

Agg1Conveyor Operates the Conveyor running from the Aggregate Hopper 1 onto 

the Main Conveyor. Will start after the Warning Siren delay 

{AxiSoft:Warning Bell Delay} has ended, and complete at the end 

of the Discharge after a time delay {AxiBatch : Conveyor Delay 

Off}. Will only run when in the Discharge Cycle and Agg1Main is 

Full Running. 

Agg1Lamp Operates when Batching Aggregates into Hopper (Agg1 Sequence 

Steps 1 to 7) and is Agg1 is Full Running. 

Agg1Vibrator Operates when the Flow Rate (discharge) has a Low Flow or once 

the Weight in the Hopper falls below X Kg until it reaches below 

the Empty Band {All Settings in AxiBatch) 

Agg1Gate1 On/Off Gate (Single Solenoid) 

Agg1Gate1Open For Inching Gates (Open Pulse) 

Agg1Gate1Close For Inching Gates (Close Pulse) 

Agg2Gate2 On/Off Gate (Single Solenoid) 

Agg2Gate2Open For Inching Gates (Open Pulse) 

Agg2Gate2Close For Inching Gates (Close Pulse) 

Agg3Gate3 On/Off Gate (Single Solenoid) 

Agg3Gate3Open For Inching Gates (Open Pulse) 

Agg3Gate3Close For Inching Gates (Close Pulse) 
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6.5 Aggregate #2 Hopper Outputs 

 

Name Operation Description 

Agg2Conveyor Operates the Conveyor running from the Aggregate Hopper 2 onto 

the Main Conveyor. Will start after the Warning Siren delay 

{AxiSoft:Warning Bell Delay} has ended, and complete at the end 

of the Discharge after a time delay {AxiBatch : Conveyor Delay 

Off}. Will only run when in the Discharge Cycle and Agg2Main is 

Full Running. 

Agg2Lamp Operates when Batching Aggregates into Hopper (Agg2 Sequence 

Steps 1 to 7) and is Agg2 is Full Running. 

Agg2Vibrator Operates when the Flow Rate (discharge) has a Low Flow or once 

the Weight in the Hopper falls below X Kg until it reaches below 

the Empty Band {All Settings in AxiBatch) 

Agg2Gate1 On/Off Gate (Single Solenoid) 

Agg2Gate1Open For Inching Gates (Open Pulse) 

Agg2Gate1Close For Inching Gates (Close Pulse) 

Agg2Gate2 On/Off Gate (Single Solenoid) 

Agg2Gate2Open For Inching Gates (Open Pulse) 

Agg2Gate2Close For Inching Gates (Close Pulse) 

Agg2Gate3 On/Off Gate (Single Solenoid) 

Agg2Gate3Open For Inching Gates (Open Pulse) 

Agg2Gate3Close For Inching Gates (Close Pulse) 

 

6.6 Aggregate Hopper Common Outputs 

 

Name Operation Description 

AggHopperMainConveyor Operates the main Conveyor running from the Aggregate 

Hopper into the Truck chute. Will start after the Warning 

Siren delay {AxiSoft:Warning Bell Delay} has ended, and 

complete at the end of the Discharge after a time delay 

{AxiBatch : Conveyor Delay Off}. Will only run when in 

the Discharge Cycle and Agg1Main or Agg2Main is Full 

Running. 

AggConveyorWarningBell Operates at the start of the Discharge Cycle and for period of 

time {AxiSoft:Warning Bell Delay}. Also occurs in Manual 

Mode. 
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6.7 Truck Bay Outputs 

 

Name Operation Description 

TruckBayRedLight Indicates not to Remove Concrete Truck from Truck Bay 

TruckBayGreenLight Indicates that the Concrete Truck can leave the Truck bay 

TruckBayMiniSock Solenoid to swing Mini Sock into Place when a Mini Truck 

is detected in a Batch 

TruckBayBigSock Solenoid to swing Big Sock into Place when a Big Truck is 

detected in a Batch 

TruckBaySockInchUp Solenoid that inches the Sock up 

TruckBaySockInchDown Solenoid that inches the Sock down 

 

6.8 Silo Outputs 

 

Name Operation Description 

Silo1Gate  

Silo2Gate  

Silo3Gate  

Silo4Gate  

Silo1SlideValve  

Silo2SlideValve  

Silo3SlideValve  

Silo4SlideValve  

Silo1FillValve  

Silo2FillValve  

Silo3FillValve  

Silo4FillValve  

Silo1Auger  

Silo2Auger  

Silo3Auger  

Silo4Auger  

 

6.9 Cement Hopper #1 Outputs 

 

Name Operation Description 

CemHopper1Gate  

CemHopper1GateOpen  

CemHopper1GateClose  

Cem1Vibrator  

Cem1Auger Will operate when Cement Hopper 1 is dumping in steps 2 and 

4 (jog). If input CemHopper1InAuto is used then Auger will 

only operate if this is energised 
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Cem1Airation  

Cem1DustExtractor  

 

6.10 Water Outputs 

 

Name Operation Description 

WaterStart Will energise for X seconds at start of batching water. Used 

for ME995-7 Water Batch Controller. 

WaterStop Will energise for X seconds at end of batching water. Used for 

ME995-7 Water Batch Controller. 

WaterReset Will energise for X seconds before start of batching water. 

Used to reset the ME995-7 Water Batch Controller. 

WaterRun Will energise during the Batching of Water, after the initial 

Water Delay on timer has elapsed 

WaterPump Will energise during the Batching of Water, after the initial 

Water Delay on timer has elapsed 

WaterValve Will energise during the Batching of Water 

WaterHopperValve Will energise during the Batching of Water 

WaterHopperValveOpen Will pulse during the Batching of Water based on flow 

WaterHopperValveClose Will pulse during the Batching of Water based on flow 

WaterHeaderTankValve Will energise when not in discharge mode and when not 

batching water when the Hopper level is below the minimum 

start value 

WaterSourceTown Energises when the “WaterSourceRecipeSwitch” input is 

energised and WaterSource in recipe is set to Town  

Or 

“WaterSourceRecipeSwitch” input is Off and both the 

“WaterSourceRecycleSwitch” and 

“WaterSourceTownSwitch” inputs are Off or the 

“WaterSourceTownSwitch” is on 

If Water Mode is set to Water Hopper TopUp or Batch then 

these valves will only energise with the above conditions and 

when the Main Hopper Batch Sequence is running to Batch or 

Topup water 

WaterSourceRecycle Energises when the “WaterSourceRecipeSwitch” input is 

energised and WaterSource in recipe is set to Recycle 

Or 

“WaterSourceRecipeSwitch” input is Off and the 

“WaterSourceRecycleSwitch” input is on and the 

“WaterSourceTownSwitch” input is Off 

If Water Mode is set to Water Hopper TopUp or Batch then 

these valves will only energise with the above conditions and 

when the Main Hopper Batch Sequence is running to Batch or 

Topup water 

WaterSpray Will energise while the Main Conveyor is Running 
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6.11 Additive Outputs 

 

Name Operation Description 

Add1Run Output to Run Additive #1 Pump via ME2008 

Add2Run Output to Run Additive #2 Pump via ME2008 

Add3Run Output to Run Additive #3 Pump via ME2008 

Add4Run Output to Run Additive #4 Pump via ME2008 

Add5Run Output to Run Additive #5 Pump via ME2008 

Add6Run Output to Run Additive #6 Pump via ME2008 

Add7Run Output to Run Additive #7 Pump via ME2008 

Add8Run Output to Run Additive #8 Pump via ME2008 

AdditivesReset Used to reset the Counters on the ME2008 Additive Controller 
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7 INPUTS 

 
This section describes all Inputs available to the system and how they 
function.  Those highlighted in orange are for future and may not be 
functional. 
 

7.1 Common Inputs 

 

Name Operation Description 

Emergency Stop OK Emergency Stop Circuit is Made 

SwitchAutoMode Auto Mode Switch (If Manual and Auto does not 

exist system will always maintain auto mode) 

SwitchManualMode Manual Mode Switch (must have Auto Switch if 

you have Manual) 

SwitchPause Pause Sequence Push Button (Used in Auto Mode) 

AggHopperMainConveyorRunning Main Conveyor Running Signal (can incorporate 

overload) 

AggHopperMainConveyorOverload Overload on the Main Conveyor 

AggHopperMainConveyorSwitch Will Control the Main Conveyor (and Piggy Back 

conveyors) in Manual Mode 

AggHopperMainConveyorBeltProx Proximity that senses the Belt Sprocket Tag 

TruckBaySockInchUpButton Button to Inch the Sock Up 

TruckBaySockInchDownButton Button to Inch the Sock Down 

TruckBayDoorClosed Truck Bay Door is closed 

SockInPlace Sock is in Position 

OKToDumpButton Button near Truck Bay to inform the system that it 

is ready to dump into the Truck 

AirCompressorPressureGood Energised means enough air pressure to batch 

  

 
 

7.2 Remote Inputs 

 

Name Operation Description 

RemoteAck Remote button that will acknowledge Over Weight alarms for 

Aggregates 

RemoteRetry Remote button that will allow a retry of Under Weight alarms for 

Aggregates or will restart a Paused system 

RemotePause Remote Button that will PAUSE the batching or discharging 

RemoteAbort Remote button that will acknowledge Under Weight alarms and 

abort to the next material or will acknowledge an Over Weight 

alarm by taking the overweight value to the next material 
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7.3 Aggregate #1 Hopper Inputs 

 

Name Operation Description 

AggHopper1ConveyorRunning Conveyor Associated to only Agg Hopper 1 is Running 

AggHopper1ConveyorOverload Conveyor Associated to only Agg Hopper 1 has 

Tripped 

AggHopper1Gate1Closed Proximity feedback switch indicating the gate is closed 

AggHopper1Gate2Closed Proximity feedback switch indicating the gate is closed 

AggHopper1Gate3Closed Proximity feedback switch indicating the gate is closed 

AggHopper1Gate1Switch Manual Switch to Open Gate 1 (Pulse) 

AggHopper1Gate2Switch Manual Switch to Open Gate 2 (Pulse) 

AggHopper1Gate3Switch Manual Switch to Open Gate 3 (Pulse) 

AggHopper1Gate1VibSwitch Manual Switch to Open Gate 1 (Pulse) and Vibrate 

Hopper 

AggHopper1Gate2VibSwitch Manual Switch to Open Gate 2 (Pulse) and Vibrate 

Hopper 

AggHopper1Gate3VibSwitch Manual Switch to Open Gate 3 (Pulse) and Vibrate 

Hopper 

AggHopper1Gate1Pos1 Proximity feedback switch indicating the gate is in 

position 1 (Low Speed) 

AggHopper1Gate1Pos2 Proximity feedback switch indicating the gate is in 

position 2 (Medium Speed) 

AggHopper1Gate1Pos3 Proximity feedback switch indicating the gate is in 

position 3 (High Speed) 

AggHopper1Gate2Pos1 Proximity feedback switch indicating the gate is in 

position 1 (Low Speed) 

AggHopper1Gate2Pos2 Proximity feedback switch indicating the gate is in 

position 2 (Medium Speed) 

AggHopper1Gate2Pos3 Proximity feedback switch indicating the gate is in 

position 3 (High Speed) 

AggHopper1Gate3Pos1 Proximity feedback switch indicating the gate is in 

position 1 (Low Speed) 

AggHopper1Gate3Pos2 Proximity feedback switch indicating the gate is in 

position 2 (Medium Speed) 

AggHopper1Gate3Pos3 Proximity feedback switch indicating the gate is in 

position 3 (High Speed) 

AggHopper1GatePos1Switch Future 

AggHopper1GatePos2Switch Future 

AggHopper1GatePos3Switch Future 
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7.4 Cement #1 Hopper Inputs 

 

Name Operation Description 

CemHopper1GateClosed Cement Hopper Gate is Closed 

CemHopper1GatePos1 Feedback Position 1 

CemHopper1GatePos2 Feedback Position 2 

CemHopper1GatePos3 Feedback Position 3 

CemHopper1GateSwitch Manual Switch to open Cement Hopper Outlet Gate or 

Auger 

CemHopper1GateVibSwitch Manual Switch to open Cement Hopper Outlet Gate or 

Auger and the Cement Vibrator 

CemHopper1GatePos1Switch Manual Switch to Open Gate to certain Position (used for 

Inching Gates). Position could be feedback or a Pulse 

Time. If not used only the 1st Pulse time is used. 

  

CemHopper1GatePos2Switch  

CemHopper1GatePos3Switch  

CemHopper1InAuto If there is an Auto/Off/Manual switch for the Cement 

Hopper then this input is used to enable Cement Hopper 

outputs such as outlet valves and Augers 
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7.5 Cement #2 Hopper Inputs 

 

Name Operation Description 

CemHopper2GateClosed Cement Hopper Gate is Closed 

CemHopper2GatePos1 Feedback Position 1 

CemHopper2GatePos2 Feedback Position 2 

CemHopper2GatePos3 Feedback Position 3 

CemHopper2GateSwitch Manual Switch to open Cement Hopper Outlet Gate or 

Auger 

CemHopper2GateVibSwitch Manual Switch to open Cement Hopper Outlet Gate or 

Auger and the Cement Vibrator 

CemHopper2GatePos1Switch Manual Switch to Open Gate to certain Position (used for 

Inching Gates). Position could be feedback or a Pulse 

Time. If not used only the 1st Pulse time is used. 

  

CemHopper2GatePos2Switch  

CemHopper2GatePos3Switch  

CemHopper2InAuto If there is an Auto/Off/Manual switch for the Cement 

Hopper then this input is used to enable Cement Hopper 

outputs such as outlet valves and Augers 

 

7.6 Water Inputs 

 

Name Operation Description 

WaterPulse Usually comes from a Flow Meter (typically an 

output from the ME995-7 Water Batch Controller 

WaterValveClosed Future 

WaterValveOpen Future 

WaterPumpRunning Future 

WaterHopperSupplyValveOpen Future 

WaterHopperSupplyValveClosed Future 

WaterHopperSupplyPumpRunning Future 

WaterHopperHighLevel Future 

WaterHopperHighHighLevel Future 

WaterHopperLowLevel Future 

WaterSourceTownSwitch Switch to tell the Town Water Valve to energise 

WaterSourceRecycleSwitch Switch to tell the Recycle Water Valve to energise 

WaterSourceRecipeSwitch Switch to tell the Town or Recycle Water Valve to 

energise based on the Recipe 
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7.7 Additive Inputs 

 

Name Operation Description 

Add1Pulse Additive #1 Tank Flow Pulse from Me2008 

Add2Pulse Additive #2 Tank Flow Pulse from Me2008 

Add3Pulse Additive #3 Tank Flow Pulse from Me2008 

Add4Pulse Additive #4 Tank Flow Pulse from Me2008 

Add5Pulse Additive #5 Tank Flow Pulse from Me2008 

Add6Pulse Additive #6 Tank Flow Pulse from Me2008 

Add7Pulse Additive #7 Tank Flow Pulse from Me2008 

Add8Pulse Additive #8 Tank Flow Pulse from Me2008 

  

 
 

7.8 Analog Inputs 

 

Name Operation Description (these are scaled using the 

iosearch software from Moxa) 

Silo1Radar Cement Silo 1 Level 

Silo2Radar Cement Silo 2 Level 

Silo3Radar Cement Silo 3 Level 

Silo4Radar Cement Silo 4 Level 

 


